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Further information 

Configuration 

1. What platforms support Java WorkShop? 
Windows 95 
Windows NT 3.51 
Solaris SPARC 2.4 or higher 
Solaris Intel Platform Edition 2.4 or higher 

2. What are the platform requirements ? 
Windows 95 

16 Mb Memory 
45 Mb free disk space 

Windows NT 3.51 
16 Mb Memory 
45 Mb free disk space 



Solaris 
32 Mb Memory 
45 Mb free disk space 

3. Can I integrate the changes made to JDK from JavaSoft? 

The Java WorkShop already contains the 1.0 JDK, along with some bug fixes. Integrating the JDK

into the Java WorkShop is not supported, and will create problems. 

Installation 

1. Be sure to delete all previous versions of the JDK as well as the Java WorkShop before
installing -- otherwise some very mystifying and difficult problems occur. 

2. Windows 95: when asked in what directory to install the software, choose a name with NO
embedded blanks. Otherwise, if you choose the default "program files", jde won’t come up. 

The examples, unfortunately, have been hardcoded to use "program files", so you will need
to edit them. (BTW, you will need to change the protection to allow editing.) 

Hints 

1. What do the 3-D icons mean on the browser footer? 

From left to right:
The left-pointing green triangle means "Back to previous URL".
The right-pointing green triangle means "Forward to next URL".
The golden house (or up-arrow) means "Return to Home"
The blue "yin-yang"-like icon is the "Reload" button
Finally, the red/pink stop sign means "Stop loading" 

2. I changed my html file, but when I run my project, the changes don’t take effect. 

The html file is cached. Use the reload button to use the new version. 

3. How can I tell when the browser is busy? 

An animated graphic has been added to the browser to the right of the URL bar. The
lighthouse beam rotates to inform you that the browser is busy loading an HTML page. 

Applets 

1. Can I use the applets I wrote with the alpha/beta JDK with Java WorkShop? 



The alpha applets most likely won’t work -- but most beta applets should. 

2. How is the base URL of an applet determined? 

There is an optional applet attribute called codebase that gives the base URL for the applet.
The applet’s code attribute is located relative to this URL. If not specified, it’s the URL of
the document in which the applet is specified. 

Error messages 

Platform independent error messages

1. "load: class <class name in all caps> not found" 

In your html code when you specify the class name, you must enter the class name in quotes.
Case is important. 

2. What does it mean when Java WorkShop says "Applet not initialized" 

Most likely you did not declare your class to be public. 

Windows 95 specific error messages

1. When I enter jde, I get the following message: 

JDE caused an invalid page fault in module JAVAI.DLL at 0137:10111ec5. 

This is an installation problem that can occur when older versions of Java have not been
deleted. 

Windows NT specific error messages

<Blank> 

Solaris specific error messages

1. When I enter jde, I get the following message:
"Motif library .../lib/libXm.so.3 not found" . 

The Java WorkShop requires Motif 1.2.3 libraries to be installed. The Java WorkShop was
not able to locate those libraries. Enter the following to see if they are installed: 

pkginfo -l SUNWmfrun 

If VERSION: is "1.2.3", then the problem is that your environment variable
LD_LIBRARY_PATH doesn’t include /usr/dt/lib. 



Otherwise, install the Motif 1.2.3 libraries. 

Currently known bugs 

Category Synopsis 

appletmanager

Synopsis: File choosers in porfolio/project don’t remember last-visited directories 

File choosers in project edit page don’t remember the last-visited directory. Pce and the
browser do remember the last-visited directory. 

Portfolio create/import and project create/import file choosers also have the same problem. 

appletmanager

Synopsis: Missing Main Class File in PM causes debugger not to stop in init/main on load. 

When creating a Project, if on the Create Project page under the Applet tab, you don’t
specify the "Main Class File" as something like "Bubbles.java", the debugger won’t stop the
applet as it brings it up. (Also see the "Main Class File" on the Edits Project Page under the
Debug/Browse tab.) 

Also "Main Class File" is confusing? Should I type in the name of a "class" file (*.class)
here? Or a "source" file (*.java) here? "Source File containing main/init" might be clearer. 

appletmanager

Synopsis: click on project run while debugger is up, popup the "kill session" dialog 

Click on project run button while the debugger is up, jde pops up the "kill session" dialog.
The dialog should not pop up. 

appletmanager

Synopsis: project creat/edit should validate that URL’s are well-formed 

project creat/edit should validate that URL’s are well-formed. Otherwise the debugger
browser doesn’t have a valid page to display. 

appletmanager

Synopsis: portfolio doesn’t treat argument strings in double quotes as a single argument 



Portfolio doesn’t treat argument strings in double quotes as a single argument. 
create a standalone project which take a string argument 
edit the run page to specify an argument string in double quotes which contains several
words 
run the project - the project doesn’t run as a single argument 

The following program can be used as a testcase:
-------------------------------------

public class Frame_0 {
   public static void main (String args []) {
      int i, count;

      count = args.length;

      if (count > 0) {
         System.out.println("count = " + count);
         for (i=0; i<count; i++) {
            System.out.println(args[i]);
         }
      }   
      else {
         System.out.println("No args");
      }  
   }   
}

appletmanager

Synopsis: project edit Included Projects list window missing bottom edge 

In project edit general folder, the Included Projects list window doesn’t have a window edge
at the bottom of the window. The problem does not affect the funtion of the tool. It’s just a
cosmetic problem. 

appletmanager

Synopsis: intel-win32 - project include list doesn’t provide a schollbar for long list 

On Windows NT, project include list doesn’t provide a scroll bar when the include list is
long. The Sparc version does provide a scholl bar. 

appletmanager

Synopsis: changing source directory for an applet project doesn’t work 

Changing source directory for an applet project doesn’t work. 
edit an existing applet project which contain source file 
edit the source directory path in the build page 
click on apply 
take down jde and then bring ut up again 



bring up project edit build page 

the source path contains the old source path, not the edited one. 

appletmanager

Synopsis: paste a project that has source files that don’t exist gives null pointer 

Create a project and give it source files that don’t exist. Copy then paste it into another
portfolio gives a null pointer exception 

appletmanager

Synopsis: classpath is incorrect 

The classpath for the builder and debugger/browser folders is incorrect 

currently: 
first the JDE classes 
then the JDK classes 
then the project’s classes 

should be: 
first the project’s classes 
second the project’s classpath 
then the JDE classes (only for debugging an applet, never for building, browsing or
debugging a standalone program) 
finally the JDK classes 

appletmanager

Synopsis: the palette does not have a scrollbar when it gets full 

The palette needs to have a scrollbar when there are more projects than can be displayed in
the browser frame. 

appletmanager

Synopsis: can’t handle moved projects 

In an effort to recover from problems related to blanks in long file names, I move the product
from c:\Program Files\Java WorkShop to c:\jws 

As expected, jde could not locate the sample checkers project and posted an error message to
this effect. The bug relates to the inability to alter the paths remembered by jde. From
Portfolio, I tried to import the project using the file browser. After selecting the Checkers.prj
file, the following message is posted: 



C:\jws\JDE\examples\checkers\Checkers.prj is already in the portfolio. 

This, although the Portfolio shows Projects: 0, and no icon visible. 

At this point it seems there is no way but to reinstall jde. 

appletmanager

Synopsis: when default portfolio is missing, PM doesn’t run 

create a project in the default portfolio 
make sure it is the default project and take jde down 
rm the project file 
start jde 
switch to PM 
nice error message about missing project, but PM applet doesn’t run 

appletmanager

Synopsis: intel-win32, jde does not come up if an <empty> .psf file exists 

If a .psf portfolio exists in the .jde/portfolios file as the (default) portfolio, and if for some
reason, has a ’0’ length, jde gives the following trace and does not come up. 

[Starting jde]
[Initialize globals]
error: null
[Creating common button bar]
[Creating frame]
java.lang.NullPointerException
        at sun.jde.portfolio.ProjectList.read(ProjectList.java:160)
        at sun.jde.base.PortfolioGlobalsImpl.getCurrent(PortfolioGlobalsImpl.java:197)
        at sun.jde.env.BrowserFrame.initToolbar(BrowserFrame.java:217)
        at sun.jde.env.BrowserFrame.<init>(BrowserFrame.java:58)
        at sun.jde.env.DCFactoryImpl.createDocumentController(DCFactoryImpl.java:29)
        at sun.jde.base.Session.createDocumentController(Session.java:99)
        at sun.jde.Main.main(Main.java:219)
Unable to create initial window.
error: null
Starting JDE...

appletmanager

Synopsis: Project Copy menu item enabled when no project selected 

When there is no selected project, either because the portfolio is empty or because the user
deselected the current project in the portfolio manager, the Project=>Copy menu item should
be disabled. This is harder, but the Project=>Paste... menu item should be disabled when
there is no project in the clipboard. 

appletmanager



Synopsis: copy/paste a project to a new project in portfolio caught exception 

copy/paste the Bubbles applet project in a portfolio caught the following exception. This bug
is in FCS jws. 

jde
[Starting jde]
[Initialize globals]
[Creating common button bar]
[Creating frame]
java.lang.NullPointerException: bar
        at sun.awt.motif.X11Graphics.<init>(X11Graphics.java:45)
        at sun.awt.motif.MComponentPeer.getGraphics(MComponentPeer.java:154)
        at sun.awt.motif.MComponentPeer.handleExpose(MComponentPeer.java:259)
        at java.lang.Thread.run(Thread.java)
Thread-11 find class Bubbles
java.lang.NullPointerException
        at sun.jde.project.ProjectUtil.validateProjname(ProjectUtil.java:82)
        at sun.jde.project.PasteImportFrame.applyCallback(PasteImportFrame.java:216)
        at sun.jde.project.PasteImportFrame.action(PasteImportFrame.java:160)
        at java.awt.Component.handleEvent(Component.java:900)
        at sun.jde.project.PasteImportFrame.handleEvent(PasteImportFrame.java:252)
        at java.awt.Window.postEvent(Window.java:165)
        atjava.awt.Component.postEvent(Component.java:845)
        at sun.jde.awt.UserTextButton.handleEvent(UserTextButton.java:60)
        at java.awt.Component.postEvent(Component.java:838)
        at sun.awt.motif.MButtonPeer.action(MButtonPeer.java:39)
        at java.lang.Thread.run(Thread.java)

appletmanager

Synopsis: default class hierarchy dir path in text field label instead of text field 

Class hiearchy directory text field used to have the label "Root directory of class hierarchy".
The fcs version does not have this label, instead it put the source directory path at the label. 

appletmanager

Synopsis: Importing the jde_dev.psf file generates an exception 

Do the following: 
Load up jde 
Select Portoflio/Import menu 
Type in .../src/sun/jde/jde_dev.psf 

I get: 

[Starting jde]
[Initialize globals]
[Creating common button bar]
[Creating frame]
java.lang.StringIndexOutOfBoundsException: String index out of range: -1
        at java.lang.String.substring(String.java)
        at sun.jde.project.ProjectItem.read(ProjectItem.java:181)
        at sun.jde.portfolio.ProjectList.setCurrent(ProjectList.java:408)



        at sun.jde.portfolio.ProjectList.read(ProjectList.java:183)
        at sun.jde.portfolio.ImportPortfolioDisplay.importPortfolio(ImportPortfolioDisplay.java:133)
        at sun.jde.portfolio.ImportPortfolioDisplay.action(ImportPortfolioDisplay.java:174)
        at java.awt.Component.handleEvent(Component.java:900)
        at sun.jde.portfolio.ImportPortfolioDisplay.handleEvent(ImportPortfolioDisplay.java:193)
        at java.awt.Window.postEvent(Window.java:165)
        at java.awt.Component.postEvent(Component.java:845)
        at sun.jde.awt.UserTextButton.handleEvent(UserTextButton.java:60)
        at java.awt.Component.postEvent(Component.java:838)
        at sun.awt.motif.MButtonPeer.action(MButtonPeer.java:39)
        at java.lang.Thread.run(Thread.java)

builder

Synopsis: build window does not show the whole long path or classpath 

When a project has a long path or long classpath, the build window doesn’t show the whole
path on its window. The long path may need to be able to wrap around or the window may
have to provide a horizontal scholl bar for scrolling. 

builder

Synopsis: build/project doesn’t check for "file up-to-date" correctly 

bring up jde 
create a project which have a java file that contained several class. In my testcase, I
used DrawTest.java which contains 3 classes: DrawTest.class, DrawPanel.class, and
DrawControls.class 
build the project to produce the above 3 class files 
delete 2 of the 3 class files that doesn’t have same name as java file. In my case, I
delete DrawPanel.class and DrawControls.class files 
build the project again. 

jde build does not build and give a message "All files are up-to-date". 

builder

Synopsis: File chooser in build page doesn’t remember last-visited directory 

File chooser in build page doesn’t remember the last-visited directory. PCE and the browser
do remember the last visited directory. 

builder

Synopsis: Build one file doesn’t check for file up-to-date 

Build one file doesn’t check for file up-to-date. 
bring up jde build page 
push-on File toggle 
enter a java filename in the text field 
build the file 



build the file again 

build does the build again which it should not. 

builder

Synopsis: File toggle on build page doesn’t change focus from project to source file 

File toggle in build page doesn’t change focus from project to source file. 
bring up jde build page 
push-on File toggle 
enter a java filename in the text field: hit return key 

build returns a message:
"Project .../xxx.java does not exist" 

builder

Synopsis: stop a build in progress, jde builder always returns with "Build Success" message 

Stopping a build in progress, jde build tool alway give Build Success message. It should give
a "stop a build success" message instead. 

builder

Synopsis: Previous and Next icons on build window don’t behave same as icons on the
editor 

After clicking on the error message, the editor comes up, If I try to use Next and Previous
icons on build windows, the highlighted bar just flickers but does not go the next or previous
error msg location. But the Next and Previous icons on the editor works just fine. 

builder

Synopsis: Previous and Next buttons not disabled before there is output 

Press the build toolbar button, when the builder comes up the previous and next error buttons
are enabled even though I haven’t even started a build. 

builder

Synopsis: The build button should be the first button 

Shouldn’t the build button be the first button on the buttonbar, and the next/prev be the last
buttons? If not, then the String Searcher should move it’s next/prev buttons to be first. 

builder



Synopsis: Intel jde - does not track changes in dependencies while building a project 

This is what happens -
choose a project 
build a project 
get errors 
edit project -> add files to the project -> Apply 
build a project -> Done. 

(instead of trying to build a project since I added a new file to the project, it reports that files
are up-to-date and there is no need to build it again) 

I had to use "Build all files even if they are up-to-date" button, 

builder

Synopsis: stop build button doesn’t stop the build 

It could be quite nice sometimes to stop a build, say you’ve noticed an error just the moment
you pressed (and released ;) the ’Build All’ button. 

builder

Synopsis: inconsistency between creating a portfolio and a project 

In consistency beween creating a portfolio and a project. Portfolio allow a portfolio to be
created on any directory. Project only allow a project to be created in the current directory
where jde is invoked. The portfolio way give users more control over where the files are to
be created. 

builder

Synopsis: Build footer says "Malformed url:" when cursor is over a build error 

When I move the cursor on the error message , jde prints "Malformed URL:" message at the
bottom of the browser window. Why is the URL malformed ? 

builder

Synopsis: build does not detect recursive build 

jde build does not detect the recursive build. 
create a project which includes itself as a subproject 
initiate the build 

the build keeps checking for file until it run out of stack space. 

builder



Synopsis: the builder does not clear old build output when changing projects 

scenario:
do a build which results in errors 
switch to the portfolio manager 
selected a different project 
press the build manager on the toolbar 

the build output from the first project is still displayed in the build output area. 

builder

Synopsis: unsaved editors popup comes up twice in the builder 

I think they are refering to the unsaved edits popup. 

Also, the save-build panel from the builder always comes up twice no matter what action
you choose. 

builder

Synopsis: problem on win95 when building in a directory whose name includes a blank 

A problem I had with Win95 (at home) is when building in a directory which name includes
a space "Program Files" . The javac command is cut between Program and Files. It fails to
compile... 

debugger

Synopsis: On win95, debugger hangs when setting a breakpoint 

On win95, debugger seems to hang when setting a breakpoint. 
scroll down the editor, click on a line then click on the "stop at line" button 
nothing happens, I click on the button again. It hangs, I can’t even scroll up the editor. 
close/open the editor window...No text or buttons show up in the editor or in the
debugger window. 
I had to force a kill on the jde window by doing a "Ctrl Alt Del" 

debugger

Synopsis: jde debugger freezes the window screen on Solaris system 

The following step will cause the window screen to freeze. The same problem existed When
I rlogin to a Intel/Solaris from a Solaris system to run jde. 

bring up jde debugger to debug an applet 
click on File menu on debugger window debugger window won’t respond here 
set a breakpoint in PCE editor window 
click on resume-all 



debugger will run to the breakpoint and then freeze the screen 

debugger

Synopsis: debugger temporary lost green hi-light current program pointer 

Debugger somtime temporary lost green hi-light current program pointer. The following
scenario will reproduce the bug. 

bring up jde debugger the green hi-light show the program stop at init() 
click on srcbrowser icon 
click on debugger icon to get back the debugger page 

the green hi-light is now lost. It will show up again when the program is stopped at a next
stop. 

debugger

Synopsis: can’t reload an applet into the debugger in order to get updated version of applet 

Bring up debugger on applet project. Use PCE to change applet source. Load builder and
rebuild applet. Page back to debugger (with debugger still up). Press reload and flush-cache,
but changes don’t show up in debugger. 

Work around: 

Use restart debugger feature to take debugger down and bring it back up again with new
applet. 

debugger

Synopsis: run-to-here at a selected comment line doesn’t stop 

bring up jde debugger 
in PCE editor, select a comment line by clicking mouse cursor on the line. 
click on run-to-here button 

debugger program doesn’t stop. It should stop at the executable code before or after the
selected comment line. 

debugger

Synopsis: debugger doesn’t recognize continuation line as a single line of code 

Debugger doesn’t recognize continuation line as a single line of code. If a single line of code
continues on several lines, breakpoints can be set or clear on each of the lines independenly
from each other. Debugger should treat all continuation lines as single line of code. 

debugger



Synopsis: Intel-win32 - Windows NT reports memory access error while running jde
debugger 

Windows NT reports memory access violation while running jde debugger. This is an
intermittent problem, but it happened 5 times today. It just randomly happened while
debugging an applet. There is no scenario to reproduce the problem. When it happened,
Windows NT pops up a window with the following messages. 

     an application errror has occurred
     and an application log is being generated
                    jde.exe
     Exception access violation (0xC0000005)  Address: 0x04742936

debugger

Synopsis: Intel-Win32 - debugger lost green hi-light program pointer in a debug session 

During a debugging session, debugger lost the green hi-lite program pointer in editor and
give out the following error in jde output. The problem is intermitten and random. Can not
find a reproducable testcase but it has happened several times. 

[Starting jde]
[Initialize globals]
[Initializing tools]
[Creating frame]
[agent: socketIn 1342]
[Starting jde]
[Initialize globals]
java.lang.IllegalAccessError
        at sun.jde.Debugger.RemoteThread.getCurrentFrame(RemoteThread.java:143)
        at sun.jde.Debugger.Debugger.autoExpandThread(Debugger.java:2115)
        at sun.jde.Debugger.Debugger.execute(Debugger.java:1116)
        at sun.jde.Debugger.Debugger.breakpointEvent(Debugger.java:1626)
        at sun.jde.Debugger.AgentIn.run(AgentIn.java:66)
        at java.lang.Thread.run(Thread.java:289)

debugger

Synopsis: Intel-Win32 - debugger freezes the monitor screen 

The following scenario will freeze the computer screen and force user to do a cold boot on
the system. 

bring up jde debugger 
run an applet 
restart 
click on source browser icon or any icon to go to another page 
click on debugger icon to get back to debugger page 
click on navigate back button 

the monitor screen now frozen and require a cold boot. 

debugger



Synopsis: debugger doesn’t evaluate some variables 

Debugger doesn’t evaluate some variables. Debugging the Blink applet program below, stop
at the end of init method and try to evaluate variable "speed". jde debugger response "not
able to evaluate speed". Using jdb, I was able to print out the value for "speed" 

/*
 * Copyright (c) 1994 Sun Microsystems, Inc. All Rights Reserved.
 */

import java.awt.*;
import java.util.StringTokenizer;

/**
 * I love blinking things.
 *
 * @author Arthur van Hoff
 */
public class Blink extends java.applet.Applet implements Runnable {
    Thread blinker;
    String lbl;
    Font font;
    int speed;

    public void init() {
        font = new java.awt.Font("TimesRoman", Font.PLAIN, 24);
        String att = getParameter("speed");
        speed = (att == null) ? 400 : (1000 / Integer.valueOf(att).intValue());
        att = getParameter("lbl");
        lbl = (att == null) ? "Blink" : att;
    }

    public void paint(Graphics g) {
        int x = 0, y = font.getSize(), space;
        int red = (int)(Math.random() * 50);
        int green = (int)(Math.random() * 50);
        int blue = (int)(Math.random() * 256);
        Dimension d = size();

        g.setColor(Color.black);
        g.setFont(font);
        FontMetrics fm = g.getFontMetrics();
        space = fm.stringWidth(" ");
        for (StringTokenizer t = new StringTokenizer(lbl) ; t.hasMoreTokens() ; ) {
            String word = t.nextToken();
            int w = fm.stringWidth(word) + space;
            if (x + w > d.width) {
                x = 0;
                y += font.getSize();
            }
            if (Math.random() < 0.5) {
                g.setColor(new java.awt.Color((red + y * 30) % 256, (green + x / 3) % 256, blue));
            } else {
                g.setColor(Color.lightGray);
            }
            g.drawString(word, x, y);
            x += w;
        }



    }    

    public void start() {
        blinker = new Thread(this);
        blinker.start();
    }
    public void stop() {
        blinker.stop();
    }
    public void run() {
        while (true) {
        try {Thread.currentThread().sleep(speed);} catch (InterruptedException e){}
            repaint();
        }
    }
}

debugger

Synopsis: unable to debug Bubbles applet if jde is executed from a remote machine 

rlogin to a remote machine 
bring up jde 
debug the Bubbles applet 

debug come up but does not bring up debugger applet window. 

Blink applet does not have this problem. We need to fix this problem soon since we use
remote log in for testing jde Intel VM. Also, when invoke the debugger from the rlogin
machine the following warning messages appear in the output. 

scully6% jde
[Starting jde]
[Initialize globals]
[Initializing tools]
[Creating frame]
[agent: socketIn 49533]
Warning: 
    Name: HorScrollBar
    Class: XmScrollBar
    The specified scrollbar value is greater than the maximum
    scrollbar value minus the scrollbar slider size.

[Starting jde]
[Initialize globals]
Warning: 
    Name: HorScrollBar
    Class: XmScrollBar
    The specified scrollbar value is greater than the maximum
    scrollbar value minus the scrollbar slider size.

[Initializing tools]

debugger

Synopsis: the quick key in the debugger doesn’t work in Win95 



For example: To "Restart", I would "shift F6" or "Resume all", I would hit "F6" 

debugger

Synopsis: in Win95, going from debugger to help tool causes a page fault 

I can only duplicate this problem when I’m running the Blink program. There are no
messages logged in weblog file. 

When first debugging the blink program, I noticed that the program is already running and
the editor doesn’t come up. 

debugger

Synopsis: Intel-Win32 - bringing up debugger sometimes hangs jde 

On WinNT, bringing up debugger sometimes hangs jde. This is an intermittent problem;
sometimes debugger comes up fine - and sometimes it comes up incompletely and hangs jde.

debugger

Synopsis: in Win95, from srcbrowser to debugger, the debugger editor does not come up 

In Win95, going from the src browser editor to the debugger, the debugger editor does not
come up. It seems the debugger is using the src browser editor. The debugger tool bar
doesn’t comes up. 

debugger

Synopsis: step "NEXT" to exit a method doesn’t stop at the line after the method caller 

Step "NEXT" to exit a method doesn’t stop at the line immediately after the line of method
caller. 

bring up debugger to debug a standalone project 
set breakpoint in a method 
step "NEXT" until exit the method 

when debugger exit the method it run to completion. It doesn’t stop at the line after the
caller. 

debugger

Synopsis: step in a method doesn’t work 

Debugger "Step" does not seem to work. 
Debug the Bubbles applet. 
Set break point to stop in update() method. 
Run the applet to stop at the call to paint() method. 



Click on "Step" to step in paint() method. 

Debugger does not move program counter to the paint() method. 

debugger

Synopsis: incorrect message when invoking debugger on a standalone program 

When invoking debugger on a standalone project, debugger give a message in jde footer
"launching 2nd browser, stand by...." This message is incorrect for a standalone program. 

debugger

Synopsis: can’t set breakpoint in a non-public class 

Can’t set breakpoint in a non-public class. 
debug a standalone program which have 1 public class and several non-public classes 
run the program 
bring up program source in a editor. 
set several breakpoints in the source. 

breakpoints are set OK in the public class but not in the non-public classes. 

debugger

Synopsis: In Win95, stepping through debugger causes a page fault 

Load in a blink applet, click on step the second time causes a page fault. 

debugger

Synopsis: app seems to reach the breakpoint in main and the displays ’restart failed’ 

The application will be started and seems to reach the breakpoint in main set by JDE and the
displays ’restart failed’. The output window shows some signals: 

pid 21064 status 0
Received sigchild for 21064 exit=0
pid 21069 status 15
Received sigchild for 21069 exit=15
[agent: socketIn 54938]
pid 21083 status 15
Received sigchild for 21083 exit=15
[agent: socketIn 54942]
pid 21107 status 15
Received sigchild for 21107 exit=15
[agent: socketIn 54948]
pid 21157 status 0
Received sigchild for 21157 exit=0

Without the debugger the application seems to run fine. 



debugger

Synopsis: JDE just crashed my X-Windows whilre running debugger 

JDE just crashed my X-Windows (i am using a PC running Hummingbirds Exceed with
Sun’s Motif as window manager). 

As far as a remember i 
started JDE 
imported a project 
started the debugger 

msg: "applet not initialized" 
started the text editor - it came up emty 
tried "Debugger, Show Classes" 

m-sg: something like "No classes available" 
i clicked on Debugger/Threads 

... and X stopped - i could move my mouse but not even switch to another window. i finally
had to reboot the pc. 

debugger

Synopsis: The evaluate window: i can’t enter a ’+’ character 

Debugger, The evaluate window: This window seems to have somthing like num-lock
associated with it, which results in that I can’t enter a ’+’ character from my keyboard (or
’<’). Im am using a PC as a X-Terminal. 

debugger

Synopsis: jde aborted on Win95 when running debugger 

Invalid page fault after setting breakpoint. 

I launched JDE and then clicked on the debugger to run an existing applet that runs OK
when run without the debugger. Another JDE window came up and then the editor with the
source code. I attempted to set a breakpoint on the first line of the init method but a message
at the bottom of the window indicated that a breakpoint couldn’t be set on the line. After a
while JDE aborted with the following error: 

JDE caused an invalid page fault in module AGENT_G.DLL at 0137:04ab2936

     Registers:

     EAX= 00000060  CS= 0137  EIP= 04ab2936  ERFLGS= 00010246

     EBX= 81550484  SS= 013f  ESP= 04bdeffc  EBP= 04bdf010



     ECX= 00000000  DS= 013f  ESI= 0067d71c  FS= 2a6f

     EDX= 0000004d  ES= 013f  EDI= 7fd84f54  GS= 2ad6

     Bytes At CS:EIP:

     8a 08 81 f9 ca 00 00 00 0f 85 0a 00 00 00 b8 06

     Stack Dump:

     7fd84f54 0067d71c 81550484 00000001 0533ff18
     04bdf02c 04ab29d8 01393928 013a7d88 7fd84f54
     0067d71c 81550484 04bdf058 1000e5d7 0067d8ac
     04bdff18

I found the following in the weblog. 

[Starting jde]
[Initialize globals]
[Initializing tools]
[Creating frame]
[agent: socketIn 1032]
[Starting jde]
[Initialize globals]
null
null
java.lang.NullPointerException
null
null
 at sun.jde.awt.IndentedListItem.find(IndentedListItem.java:762)
 at sun.jde.awt.IndentedListItem.find(IndentedListItem.java:762)
 at sun.jde.Debugger.Debugger.autoExpandThread(Debugger.java:2100)
 at sun.jde.Debugger.Debugger.execute(Debugger.java:1116)
 at sun.jde.Debugger.Debugger.breakpointEvent(Debugger.java:1626)
 at sun.jde.Debugger.AgentIn.run(AgentIn.java:66)
null
null
 at java.lang.Thread.run(Thread.java:289)
null
null
null
Exception in thread "AWT-Callback-Win32" java.lang.NullPointerException
 at sun.jde.awt.IndentedListItem.makeInvisible(IndentedListItem.java:826)
 at sun.jde.awt.IndentedListItem.makeInvisible(IndentedListItem.java:826)
 at sun.jde.awt.IndentedListCanvas.paint(IndentedList.java:365)
 at java.awt.Component.update(Component.java:583)
 at sun.awt.Win32.MComponentPeer.update(MComponentPeer.java:152)
 at sun.awt.Win32.MComponentPeer.handleRepaint(MComponentPeer.java:278)
null
 at sun.awt.Win32.MToolkit.run(MToolkit.java:57)
 at java.lang.Thread.run(Thread.java:289)
null
null
null (the null’s are repeated about 3400 times!)

debugger

Synopsis: trouble setting breakpoints 



Problems with the mechanism for setting breakpoints. 

1. I compiled the following applet with debug (-g option) and clicked on the ’Debugger’
icon. I had been having trouble setting breakpoints on some lines of executable code
and got the following message: 

Unable to set breakpoint: No code at line xx, or class is not optimized. 

I then attempted to set breakpoints on all executable lines of code in the program and
found that I was only able to set breakpoints on the lines marked with an asterisk. Note
that lines 33 and 89 are blank lines! The debugger seems confused about which lines
can have a breakpoints and which cannot. 

2. While setting breakpoints, I noticed that setting a breakpoint on a line a second time
causes the line to be displayed twice in the breakpoint list. This occurs when the
breakpoint is set with the editor icon or with the ’Breakpoints’ tab. Duplicate
breakpoints on the same line should be ignored. 

3. Breakpoints in the breakpoint list seem to be displayed in random order. They should
be sorted by class name and line number. 

4. When the debugger is activated a breakpoint is always set on line 47. If a breakpoint is
supposed to be set at the beginning of the ’start’ method (I don’t know why this is
necessary), it should be set on the first line of the method rather in the middle. 

The applet runs with the following HTML. 

     <applet name="ScrollText" code="ScrollText.class" codebase="d:/Dev3_test/ScrollText" width="300" height="300"
     hspace="99" align="Right"><param name="text"
     value="Now is the time for all good men to come to the aid of their country.">
     <hr>If your browser recognized the applet tag, you would see an applet here.<hr>
     </applet>

     1  import java.awt.Graphics;
     2  import java.applet.Applet;
     3  import java.awt.Font;
     4  import java.awt.Color;
     5  import java.awt.FontMetrics;
     6  import java.awt.Event;
     7  import java.awt.Image;
     8
     9  public class ScrollText extends Applet implements Runnable {
    10  String input_telt;
    11  Font font = new Font("Helvetica", Font.BOLD,20);
    12  Color color = new Color (255, 0, 0);
    13  int xpos=0;
    14  int realLength;
    15  int realHeight;
    16  int height=50;
    17  int width=500;
    18  Thread killme=null;
    19  Image im;
    20  Graphics osGraphics;
    21  boolean suspended = false;



    22  * 23    public void init() {
    24    input_text=getParameter("TEXT");
    25    im = createImage(size().width, size().height);
    26    osGraphics = im.getGraphics();
    27    }
    28
    29    public void paint(Graphics g) {
    30    paintText(osGraphics);
  * 31    g.drawImage(im, 0, 0, null);
    32    }
    33
    34    public void paintText(Graphics g) {
    35    g.setColor(Color.blue);
    36    g.fillRect(0, 0, width, height);
    37    g.clipRect(0, 0, width, height);
    38    g.setFont(font);
    39    FontMetrics fmetrics = g.getFontMetrics();
    40    realLength = fmetrics.stringWidth(input_text);
  * 41    g.setColor(color);
    42    g.drawString(input_text, xpos, (height+realHeight)/2);
    43    }
    44
  * 45    public void start() {
    46    if (killme == null) {
  * 47      killme = new Thread(this);
    48      killme.start();
  * 49      }
    50    }
  * 51
    52    public void setcoord() {
    53      xpos = xpos-5;
    54      if (xpos < -realLength) {
    55        xpos = width;
    56      }
  * 57    }
    58
  * 59    public void run() {
    60    while (killme != null) {
  * 61      try {Thread.sleep(100);} catch (InterruptedException e) {}
    62      setcoord();
    63      repaint();
    64      }
    65    }
    66
  * 67    public void update(Graphics g) {
    68      paint(g);
  * 69      }
    70
  * 71    public boolean handleEvent(Event evt) {
    72      if (evt.id == Event.MOUSE_DOWN) {
  * 73        if (suspended) {
    74          killme.resume();
  * 75        } else {
    76          killme.suspend();
  * 77          }
    78        suspended = !suspended;
  * 79      }
    80      return true;
  * 81    }
    82
  * 83    public void stop() {



    84    if (killme != null)
    85      killme.stop();
    86    killme = null;
    87    }
    88  }
  * 89

debugger

Synopsis: bringing up debugger causes IOException 

Bring up FCS debugger (built 03/16/96) cause IOException. I also noted that the debugger
buttons on PCE don’t appear clear (their color intensitive is dim, look like they are grayed
out).. 

dnp39% jde
[Starting jde]
[Initialize globals]
[Creating common button bar]
[Creating frame]
[agent: socketIn 35416]
[Starting jde]
[Initialize globals]
java.io.IOException
        at sun.awt.image.GifImageDecoder.readHeader(GifImageDecoder.java:197)
        at sun.awt.image.GifImageDecoder.produceImage(GifImageDecoder.java:105)
        at sun.awt.image.InputStreamImageSource.doFetch(InputStreamImageSource.java:215)
        at sun.awt.image.ImageFetcher.run(ImageFetcher.java:98)

doc

Synopsis: Debugging Applets/What is the Call Stack/Second Paragraph repeats "in the" 

Debugging Applets/What is the Call Stack/Second Paragraph reflects the following. 

"The Debug page reports the name of the current method in the in the status area." 

It should be: "The Debug page reports the name of the current method in the status area." 

doc

Synopsis: get an offset error when using help 

I get an offset error when using help. 
on splash page, click "online help" 
click on "Browsing source" 
click on "Class Browser" 
click on "javadoc" 

The following error message in display on the shell window. 

Error offset 4363: Expecting an attribute name



doc

Synopsis: On Win95, Main Class filename is case sensitive 

On Win95, Main Class filename is case sensitive otherwise the debugger will not be able to
find the file. The name has to be the same as in the .html file. This needs to be documented.
Because in Win95 or NT, it is not case sensitive. 

doc

Synopsis: in Win95, background window is transparent on the JDE window. 

Only part of the background window is transparent. By closing and opening the JDE
window, would refresh it. 

doc

Synopsis: in Win95, unable to bring up jde with & as indicated in download instruction 

I get the following error message in weblog file: 

error:malformed URL: &

you cannot run jde in the background. 

doc

Synopsis: bold fonts do not line up with regular text 

You can see this on the project home page.... 

on-line-->Getting Started-->Project 

doc

Synopsis: non-inutitive user interface - so for now provide more help 

P.S.: several of my colleges [sic] have taken a look at JDE and the major two complaints are
SPEED !! and the non-intuitive user interface. So you should at least put some more work
into the on-line help and add a more detailed tutorial. 

Regarding the help: by switching between projects and debugging etc. (i don’t remember
what) i reached a state, where the main JDE help page was shown but i couldn’t go to any of
the topics (and while i am complaining: why are there only buttons and no links on the main
page ? i read the text and instead of clicking on the text i wan’t to follow, i have to take a
look at the buttons and select the topic there) 

doc



Synopsis: Win95: must remove previous JDKs before installing jde 

On installation the user is asked what directory is to contain the new jde. If this directory has
another JDK already installed in it, and some of the files do not have delete permission, then
they will remain in place along with the new software. 

Work around: Make sure all previous JDKs are removed before installing. 

editor

Synopsis: On Win95, texts are underline when typing in the editor 

On Win95, All the texts are underline when typing in the editor. After closing the window
and opening it up, the underline goes away but when I start typing again the texts are again
underline. 

editor

Synopsis: jde editor change file access mode of the file after saving file 

When saving a file, editor always change access mode to "-rw-rw-r--". 

created a file xxx with access mode "-rwx-rwx-rwx" 
bring up jde editor 
open file xxx 
save file xxx 

the new xxx file now has access mode "-rw-rw-r--" 

editor

Synopsis: Can’t see the end part of a long line in editor 

If an edit file have long line, there is no way to see the end part of the line within the editor.
The special keys will take the cursor to the end of the line but currently the special keys do
not work. 

With the new build the special keys are now fixed. However, it would be nice to have a
horizontal scroll bar to scroll to the end of the long line. 

editor

Synopsis: editor does not set cursor position when loading the edit file 

Editor does not set cursor position when loading the file. 
bring up jde editor 
load a text file 
type Ctrl-F to do a find operation 



the find popup window does not come up. 

If point-and-click before type Ctrl-F then the find popup window come up OK. 

editor

Synopsis: Not quoting Relative URL’s cause a bad link 

If you have two urls such as 

<A href=AU.html>text </A>
<A href="AU.html">text </A> 

The one with the quotes will be OK but the one with out the quotes will look like it is
pointing to AU.HTML instead of AU.html. 

<A href=AU.html>text </A>
<A href="AU.html">text </A> 

The one with the quotes will be OK but the one without the quotes will look like it is
pointing to AU.HTML instead of AU.html. 

editor

Synopsis: Intel-Win32 - extra back slash in editor file name title 

On window NT, an extra back slash appears in the file pathname of editor title. 
bring up jde editor 
load file c:\java_ws\test.java 

the editor now contain the following title:
\c:\java_ws\test.java 

editor

Synopsis: On Win95, editor doesn’t save an edit file when in reuse mode 

On Win95, editor doesn’t save an edit file when in reuse mode. 

On in scrbrowser, click on a constructor link. 

editor will come up with source. 
Change some line it in (make sure reuse box is check). 
click on the debugger (from the toolbar) 

According to the docs, a dialog box should come up and give the the user an option to
use an additional editor window or save the current file. 
In this case, the debugger will use the save window with the edited file. 



I notice on SPARC version, the dialog box does comes up either so the docs will need to be
changed or the feature has not be implemented. 

editor

Synopsis: "Find" functionality doesn’t wrap to the beginning of the file 

Find starts its search from the current position and searches until the end of the file. It does
not prompt the user to wrap and start searching from the beginning of the file when it hits the
end of file. 

editor

Synopsis: unsaved edits popup doesn’t say which file or even that it is for the editor 

The unsaved edits popup does not tell me what file has been changed that it is prompting me
to save. It will need to handle the case where I have changed several files without saving
them. 

I was not in PCE when I decided to quit JDE so at first I didn’t realize which tool displayed
the popup, the title just says "Quit" and then there are 3 buttons: 

"Save, then Quit" 
"Don’t Save, and Quit" 
"Cancel" 

It wasn’t clear that this had to do with PCE. 

editor

Synopsis: only first character of a word gets selected if the word begins in column 1 

On PCE editor, when double mouse click on a word to select it, only first character of the
word is selected if the word begins in column 1. 

editor

Synopsis: Intel-Win32 - editor doesn’t show footer label for tool button on tool bar 

When moving the cursor across the editor tool bar and stop at a tool button, the tool button
label does not show up in the footer of the editor. However, if move the cursor vetically to
the tool button the label will appear in the editor footer. 

editor

Synopsis: in Win95, the word does not get highlighted when repeating a search 

In Win95, when repeating a search on a word, the next word does not get highlighted. The
first word found stays highlighted and you can see the cursor moved to the end of the next



word found. 

In the editor, go to Edit -> find 
find window comes up, type in a word, hit "OK" 
repeat the last command by going to Edit -> Repeat Last 

editor

Synopsis: After File/New command, you can’t reload the same file. 

If you clear the contents of the editor with the File/New command, the editor refuses to
reload the same file. 

editor

Synopsis: can’t see hilite in editor when there is a marker 

I used the string searcher to locate some strings. I select the link to warp to the editor and it
hi-lites the line I want to edit. When I select some text, the selection does not show up. I
cannot tell what I have selected. 

editor

Synopsis: unable to copy text from shell window and paste it in the editor 

unable to copy text from shell window and paste it in the editor. I can’t use the keyboard
"copy" and "paste" to do this. 

editor

Synopsis: Text of error msg does not appear in PCE footer 

Text of error msgs do not appear in PCE footer when error browsing. When browsing errors
in PCE on a build with multiple errors, it is difficult to coorelate the source line highlighted
in PCE with the error message in the build output display. The only way now is to look at the
Line info in PCE and find the cooresponding source line in the error msgs in the build
output, which causes the user to look back and forth between PCE and the build output. 

editor

Synopsis: editor create 2 set of "up and down error" buttons on editor tool bar 

The following operation cause PCE editor to generate 2 set of "previous and next error"
button on the editor tool bar. 

create a project which contain error in java source code 
bring up build page and build the project 
click on project edit icon to bring up project edit page 



click on build icon and build the project again 
click on error link to warp to source on PCE editor 

the editor tool bar now contain 2 set of previous and next error. 

editor

Synopsis: the filter should be set to the source directory of my project 

When I "Open a file..." in the editor the first time, the file chooser filter contains the
directory of where I started jde, it would be nice for the filter to contain the source directory
of the current project, since I probably want to edit a source file in the project. 

editor

Synopsis: deleting a line highlighted due to a string search match causes problems 

I used the source browser to grep for a string in a project, then clicked on a match to go to
the source code in PCE. I then selected the matched line, although it was hard to tell I
selected it because it still had the source match highlight, then I deleted the line and then
when I pressed the BackSpace key the line above the original highlighted line became
highlighted and displayed the source match glyph. 

editor

Synopsis: "find" in editor never returned 

(This is part of the dogfood test). 

Load the file src/sun/jde/tags/A.tag into the editor. Use the find feature to search for
the string: getTextStyle The footer says "Searching...." and never returns. The string
does exist in the file. 

editor

Synopsis: Start a new file, the typed data not displayed 

When the editor is loaded with a file, I started a new file the typed something. The typed data
were not displayed but the Line: and Column: fields were increased. The data were still there
just not displayed. 

editor

Synopsis: entering text to a new file, window focus change to "Line:" text field 

bring up jde editor to create a new file 
enter text into editor window 
when the page full, editor bring a vertical scroll bar and then change the window focus



to "Line: " text field. 

Text now is enter to the text field instead of editor window. 

editor

Synopsis: Entering a column in the status bar does not handle tab characters properly 

If you do the following: 
pop up the editor 
add some text with two or three tabs to start 
enter 5 in the column type in field 
the editor puts the cursor five characters into the line, It should position the cursor to
the nearest column to column 5. 

editor

Synopsis: Selecting save on exit with edits in a new editor doesn’t save the edits 

If you do the following: 
pop up the editor 
add some text 
select File/Quit from the browser menu 
select Save, then quit on the exit popup 
the edits are not saved 

The editor should pop up a save-as file chooser for the buffer. This is a hard bug to fix, since
the user is in the midst of leaving the whole environment. We need to understand what
cancelling would mean at each step of this exit process. 

editor

Synopsis: no footer label for reuse button when editor not in "Use for tool display" mode 

When editor in "Use for tools display" mode, place mouse cursor over the reuse button, the
button label show up at the footer. When the editor not in "Use for tools display mode", no
label appear in the footer. The label should appear in both cases to be consistency. 

editor

Synopsis: Switch PCE Match and Warning icons to avoid confusion 

The PCE Open File/Save File icons are similar in appearance to the Next/Previous Match
buttons. Please switch them with the Next/Previous Error (build) buttons. Might also
separate the Open/Save icons from the others with some space. 

editor



Synopsis: Help icon missing from PCE toolbar 

The Help icon is missing from the PCE toolbar. 

editor

Synopsis: extra builder buttons on builder 

sparc 
start jws 
load builder 
load pce 
close pce * 
reload builder 
load pce 

pce now has two sets of builder buttons 
goto * 

this can be repeated to add more buttons 

htmleditor

Synopsis: applet panels let events pass up to editor window that contains them 

When selecting an ActiveLink (the kind of applet used in the JDE help pages), you
sometimes see a portion of the document window turn dark grey, as if you were selecting the
area around the applet. This can occur when the mouse moves slightly between press and
release. 

To see this, do: 
1. start JDE 
2. select the Help button on the toolbar 
3. press and hold down the left mouse button over the "Getting Started" icon on the page 
4. move the mouse slightly (an area in the window will become selected) 
5. release the mouse button (the icon will animate and a new page will be loaded) 

The mouse events are handled by the ActiveLink applet, and cause you to switch to a new
page, but they should NOT also be handled by the EditorWindow. The AppletPanel class
which contains the applet is likely allowing events on the Applet to be propogated upward. It
should NOT allow any such events to be propgated (even when the applet, in this case
ActiveLink, is possibly in error, by handling the event and then returning false from it’s
handleEvent call as if the event were not handled.) 

htmleditor

Synopsis: no updates are given by the browser when applets are being loaded 

The browser gives no updates during the loading of applets (or any other kind of large data,



like images, for example.) This creates a situation for users where they may be forced to wait
a long time for applet code to load without any feedback from the brower. To observe this
behavior, try loading any page with an applet in it. The only feedback given is that the
document itself is being fetched. 

htmleditor

Synopsis: there is no "do you want to save edits?" popup in the htmleditor 

The browser/editor won’t ask you before quitting whether you want to save unsaved edits in
a document loaded in the browser. The only way to create this situation currently is to paste
an applet tag into a document (an applet tag placed in the cut buffer by performing the "Copy
Applet" operation in the Applet Palette.) If you modify a document in this way, you are
allowed to quit, without saving it, and without any warning. 

htmleditor

Synopsis: File=>Save As... adds garbage characters in saved file 

Load http://java.sun.com/applets/applets/Blink/Blink.java select File=> Save
As... and specify a filename, the saved file contains lots of garbage characters: 

font = new java.awt.Font("TimesRoman", Font.PLAIN, 24); 

String att = getParameter("speed"); 

is saved as 

font = new java.awt.Font("TimesRoman", Font.PLAIN, 24); 

String att = getParameter("speed"); 

htmleditor

Synopsis: The browser doesn’t handle nested <dl> tags correctly. 

The browser doesn’t handle nested <dl> tags correctly. 

htmleditor

Synopsis: tag images don’t display properly when tags mode is started in the browser 

When "Options->tags" is selected from the brower menu bar, the tag images are supposed to
appear around each item in the document that represents a tag. The letters (of the tags)
appear immediately, but the pretty colored boxes that are supposed to be around them don’t
show up until you cause the window to be redrawn somehow. 

other



Synopsis: Links inside <CENTER> tag don’t work. 

Links inside <CENTER> tag don’t work. 

other

Synopsis: paging up/down in browser improperly aligns text 

When paging up or down with the browser, if the bottom or top line has been partially
clipped, it will currently NOT be reproduced in its entirety when the next section is read in. 

For example: 

Line 1 <- visible
Line 2 <= visible
Line 3 <- bottom of page clips this in half - only top half visible
Line 4 <- obscured

page down using the elevator and the Select button 

Now you will see the bottom portion of Line 3 and all of Line 4. What you *SHOULD* see
is ALL of Line 3 and Line 4. Otherwise, text is easily missed, and in the right context, may
not be noticed as missing. 

Line 1 <- obscured
Line 2 <- obscured
Line 3 <- top half obscured, bottom half visible
Line 4 <- visible

Work around: 

Always move up or down a line when paging to make sure you have not missed a line. 

other

Synopsis: cloned browser returns incorrect current portfolio and project 

Scenario: 

File=> Clone to clone the browser
Portfolio=> Choose => xxx to choose a different portfolio in the cloned browser

The cloned browser displays the correct information in the palette and in the Portfolio and
Project labels but internally it thinks the current project is the project from the original
browser. For example, if you press the Edit Project button it loads the project editor on the
current project of the original browser. 

other



Synopsis: progress animation icon doesn’t stop when jde finish loading jde pages 

Progress animation icon sometime doesn’t stop when jde finish loading jde super-applet
pages. The following scenario will reproduce the bug. 

bring up jde 
click on jde buttons below in a consecutive sequence srcbrowser-debugger-srcbrowser 

the lighthouse animation icon now running and won’t stop even when srcbrowser page is
finished loading 

other

Synopsis: On Win95 in help, close and open window causes the icon to line up on left side 

On Win95 in help, close and open window cause the icon to line up on left side of the page
instead of at the top of page. When I scroll down, it will reposition itself to the top of the
page. This is probably related to the refresh problem. 

To reproduce the bug: 

Go to help 
debugger help 
close and open window 
scroll down the window 

other

Synopsis: can’t load jde external page from jde browser - IO Exception 

Load the following URL to get to jde external web site cause "IO Exception" appear in jde
footer. Also error in jde output. 

http://sw.sun.com/javaWS/ 

        
dnp58% jde
[Starting jde]
[Initialize globals]
[Initializing tools]
[Creating frame]
Error offset 342: Expecting an =
Error offset 633: Expecting an attribute name
Error offset 841: Expecting an attribute name
Error offset 1070: Expecting an attribute name
Error offset 1276: Expecting an attribute name
Error offset 1483: Expecting an attribute name
dnp59% jde
[Starting jde]
[Initialize globals]
[Initializing tools]



[Creating frame]
Error offset 342: Expecting an =
Error offset 633: Expecting an attribute name
Error offset 841: Expecting an attribute name
Error offset 1070: Expecting an attribute name
Error offset 1276: Expecting an attribute name
Error offset 1483: Expecting an attribute name

other

Synopsis: the ’about Usage Tracking’ window is too big for (Win32) 640x480 screen 

When jde first started, the ’about Usage Tracking’ window is too big for 640x480 (default)
resolution users on NT/Win95. The "Accept" and "Decline" buttons are displayed outside the
screen scope and can not be reached. 

Work around: Adjust the display to higher resolution (e.g. 1024x768) before running jde 

other

Synopsis: JDE creates a .hotjava directory 

dev3 creates a .hotjava directory and uses hotjava.home. It should be using .jde and
jde.home. 

other

Synopsis: in Win95, build hang when building a thread program with exception in it 

In Win95, build hang when building a thread program. I built the same program on sparc and
it seems to build with errors which is expected. I tried hit the stop button but it still stays in
the build state. 

Here is what’s in the weblog: 

-------------------------------------------------------------
java.util.NoSuchElementException
        at java.util.StringTokenizer.nextToken(StringTokenizer.java:117)
        at java.util.StringTokenizer.nextToken(StringTokenizer.java:139)
        at sun.jde.build.ExecBuild.makeHREF(ExecBuild.java:402)
        at sun.jde.build.ExecBuild.run(ExecBuild.java:192)
--------------------------------------------------------------

‘ 

Here is the program I used: 

-----------------------------------------
import java.awt.*;
import java.applet.Applet;

public class MonkeyTyper extends Applet {
        Monkey monkey;



        MonkeyObserver ovserver;
        Label label;

        TextField display;

        public void init()
        {
                resize(300,300);
                label=new Label("Monkey Writer: ");
                display=new TextField("",55);
                add(label);
                add(display);

                monkey=new Monkey();
                monkey.start();
                observer=new MonkeyObserver(monkey,display);
                observer.start();
        }
}
class Monkey extends Thread {
        String message;
        public Monkey() {message="";}
        public String whatDidYouSay() {return message;}

        public void run()
        {
                while(true)  {
                        message += (char)(Math.random()*(’z’-’a’)+’a’);
                        if (message.length() >= 50) message = "";
                        try sleep(200); catch (Exception e) {}
                }
        }
}

class MonkeyObserver extends Thread {
        Monkey monkey;
        TextField display;

        public MonkeyObserver(Monkey m,TextField t) {monkey=m; display=t;}

        public void run()
        {
                while(true) {
                        display.setText(monkey.whatDidYouSay() );
                        try sleep(200); catch (Exception e) {}
                }
        }
}
-----------------------------------------

other

Synopsis: Superapplets do not resize when browser is resized 

Try resizing the browser larger, and the superapplets stay the same size. 

other

Synopsis: Toolbar buttons don’t pop back up at the right time 



If focus remains on the button pushed, it will not pop back up until focus moves away from
the button. 

If focus is removed immediately after depressing the button, it won’t pop back up until focus
returns to anywhere on the toolbar. 

After they are pushed and released, toolbar buttons do not immediately return to the "up"
position. They remain in the "down" position until their action is complete. It would be less
confusing if the button returned to the "up" position when the user releases the mouse button.

other

Synopsis: Browser does not display JDK1.0 web page correctly 

Browser does not display JDK1.0 web page correctly. This is important because we provide
a link to it from the JDE Help menu. 

other

Synopsis: TOC applet only displays last entry when you return after following a link 

TOC applet only displays last entry (Index) when you return after following a link. 

other

Synopsis: TOC applet: Using # to pass URL causes NullPointerException 

Passing the calling URL to the toc applet causes a null pointer exception. 

java.lang.NullPointerException: bar
        at sun.awt.motif.X11Graphics.<init>(X11Graphics.java:45)
        at sun.awt.motif.MComponentPeer.getGraphics(MComponentPeer.java:154)
        at sun.awt.motif.MComponentPeer.handleExpose(MComponentPeer.java:259)
        at java.lang.Thread.run(Thread.java)

other

Synopsis: jde displays applets on top of one another when running project with 2 applets 

I have a project whose *.html file has two applet tags. When I run it in netscape, the two
applets appear one under the other in the browser window. When I run it in jde, second
applet gets mapped on the first applet. 

other

Synopsis: applet stop running in debugger if mouse cursor is set in applet window 

Applet stop running in debugger if mouse cursor is set in applet window. 
debug an applet 



run the applet in debugger 
move mouse cursor to the applet window 

the applet now stops running. Move cursor out of the window, the applet will resume
running. 

other

Synopsis: In Win95, URL is grayed out when changing from standalone to applet 

In Win95, Project Manager, When changing the type from standalone to applet, the URL
path is grayed out. But when I go to Portfolio manager or build and come back to Project
Manager, I can edit the URL pathname. 

Project Manager toolbar-->General--type: change standalone to applet. 
Debug/Browser-->URL (is grayed out) 

other

Synopsis: browser shouldn’t exit when started on invalid URL, causes debug startup failure 

browser shouldn’t exit when started on invalid URL, causes debug startup failure. In this
case a bad URL in a project was being handed to the debugger browser at startup, which
exited. Browser should come up anyway with error URL. 

other

Synopsis: scrolling in the browser is painfully slow 

I’m trying to read some help pages and need to scroll down. It’s so slow that I end up hitting
and hitting the scrollbar and miss the location I want. Reminds me of trying to steer a
houseboat - you turn the wheel and nothing happens. So you turn it some more. When it
finally starts turning, you’ve turned too far. 

Anyway, I finally decided to just print the help page. 

other

Synopsis: No feedback on why version control fails 

I just tried to check out a file and it failed. The user is given no feedback as to why. The only
reason I knew it failed was because the status in the footer didn’t change. Then on the shell I
see: 

pid 3058 status 6
Received sigchild for 3058 exit=6

That gives me no clue. 

other



Synopsis: On Win95, import button in project manager seems to disappear when selecting it 

Click on project manager icon, selected IMP icon to import an project. The import project
comes up with the import icon in it. Closing and opening the "import project" window seems
to make the IMP icon go away but closing and opening jde, doesn’t make the IMP icon to
reappear. 

other

Synopsis: apply, reset buttons in properties->path activate properties->proxies and ports 

Apply, reset, buttons in hotjava preference->paths folder also activate entries in hotjava
preferences->proxies and ports folder. And vice versa. It would be better to have the buttons
activate only in the focus folder. 

other

Synopsis: sometimes hitting a button on the toolbar causes browser to go into flicker mode 

Sometimes a superapplet won’t load - instead the browser goes into some major song and
dance where it looks like the scrollbars are flickering and the applet never shows up. 

other

Synopsis: Bullets placed incorrectly in bulleted lists 

Bullets are not placed correctly in some bulleted lists. Check out:
doc:/lib/html/help/pce/basic.html 

Bullets are incorrectly placed on the second line of 2 line bullet items. 

Some items are missing bullets. 

The description field as copied from the bug report follows: 

When looking at the release notes 
doc::/lib/html/help/site/release_notes.html 

the bullets show up in incorrect places, even though the release notes’ html tags are written
correctly.. 

Look at section "1. What’s New in Dev 3", subsections: "Source Browser" There is no bullet
in front of "Class Browser"; instead it appears on the next line. 

"Portfolio and Projects" There is no bullet in front of "View the projects..." 

other



Synopsis: options=>proxies doesn’t allow PC users to set mail gateway 

Netscape 2.0 provides an option for specifying the address of an outgoing mail server to
allow mail to be sent from within Netscape without requiring mail capabilities on Windows
95. Since the ’Comment’ mechanism also uses E-mail, a capability similar to Netscape’s
should be added - otherwise the everything goes into a black hole. 

other

Synopsis: submiting a comment, jde comment box doesn’t check for empty comment box 

jde comment box doesn’t check for a blank comment. 

other

Synopsis: The TextView widget for PRE tag does not expand tabs. 

The TextView widget for PRE tag does not expand tabs. On Solaris, it replaces it with a
blank. On Windows NT, it replaces it with a square. 

This shows up in the String Searcher. Pick a string that will match a line that has a tab. 

other

Synopsis: Attempts to quote the path elements in Edit Project results in an error under
Windows 95 

Unquoted path elements with spaces are truncated at the first space by DOS. Attempts to
quote the path elements in Edit Project results in an error, evidently because the quote marks
are not accepted by jde. When jde sets the defaults at install time, the path elements with
embedded spaces, like "Program Files", should have quotes added. 

other

Synopsis: How can I get MinimalDecor to work? 

I like to run some applications under OpenWindows with "MinimalDecor" set: this way I
devote as much screen real estate as possible to the application, whic I use a lot, and none to
the window manager, which (a) I use only a little, and (b) is still available by careful
positioning of the mouse pointer on the window border. 

But "jde" doesn’t seem to be the name of the window so far’s the window manager is
concerned, nor is it "Java Workshop" so far as .Xdefaults is concerned. Here’s the relevant
entry in my .Xdefaults: 

OpenWindows.MinimalDecor:       perfmeter olvwm sunclock xemacs emacs netscape perfbar Netscape maker frame "Java Workshop"

I tried it with "jde" instead of "Java Workshop" and also "Java WorkShop" (capitalization)
all to no avail. 



How can I get MinimalDecor to work? 

FWIW, this is with olvwm 3.3. 

other

Synopsis: double clicked on the window manager-provided namestripe, and got overwritten. 

I double clicked on the window manager-provided namestripe, and got page full of
overwritten text. Choosing window manager’s menu item "Refresh" cleared things up. 

When I double-clicked the namestripe, it would always lengthen to the size of the screen,
BUT only sometimes it would leave a blank white box where it was supposed to redraw. 

The description field as copied from the bug report follows: 
1. Invoke "jde". 
2. From Java WorkShop screen select "<Help> Workshop for Java Help" 
3. From the Java WorkShop Online Help screen, resize the window to a larger size (

approximately 1 1/2 inches) by clicking SELECT on upper right corner. 
4. Overwriting of text will appear on the screen. Pressing Refresh button at bottom of

screen will NOT clear screen. 
5. When the browser is resized, the text on the help page is not refreshed properly; they

get overlaid over one-another.
eg: (main page) -> (help) -> (resize the browser) 

6. Reloading the page, when the above happened, make its worse; it to be pushing the
previous badly painted page down while overlaying text again. 

other

Synopsis: jde is too slow 

Several of my colleges [sic] have taken a look at JDE and the major two complaints are
SPEED !! [and ...?] 

other

Synopsis: All class files are looked for with names all in caps 

All class files are looked for with names all in caps, which is wrong on a Solaris system
(may be ok under Win95?) 

Earlier today, I sent a message about loading classes in all caps which made the JDE browser
fail to load a perfectly working applet 

Here is the detailed message. I personnally find it amazing that it tries to load this file 

Thread-6 find class GRAPHE.CLASS
Opening stream to: file:/elec/cao/dufourd/work/classes/MosSimulator/GRAPHE/CLASS.class to get GRAPHE.CLASS



load: class GRAPHE.CLASS not found

PS: IBeam cursor is mostly invisible in this window ("send Comments") 

other

Synopsis: jde aborted 

This is an intermittent problem and has only occured once. 

Shortly after I clicked on the icon to start jde, the application aborted with the following
error message: 

     JDE caused a stack fault in module JAVAI.DLL at 0137:1000d38f

     Registers:

     EAX= 051dff30  CS= 0137  EIP= 1000d38f  ERFLGS= 00010246

     EBX= 00658cb5  SS= 013f  ESP= 051df548  EBP= 00000000

     ECX= 0000050b  DS= 013f  ESI= 006f1c2c  FS= 230f

     EDX= 8154f648  ES= 013f  EDI= 006f3949  GS= 0000

     Bytes At CS:EIP:

     f6 45 10 08 8b 4d 04 0f 85 27 26 00 00 8b 45 14

     Stack Dump:

     10024d39 7fd84f54 00000000 006dffec 00df3948
     006e011c 006e00fc 006e00d8 05160052 006dffec
     006f5547 00000000 051dff34 0000050b 3fe80000
     00000000

other

Synopsis: JDE caused a stack fault in module JAVAI.DLL at 0137:1000d38f 

This email reports a bug on the Windows 95 platform 

These weblog entries may have occurred at the time of the following error that I reported
earlier today. It looks like it was trying to access a field containing garbage. 

     JDE caused a stack fault in module JAVAI.DLL at 0137:1000d38f

[Starting jde]
[Initialize globals]
[Initializing tools]
[Creating frame]
java.lang.NoSuchFieldError: (Ljava.awt.Event;)Z: field >o^H^Su^E?^P not found
 at sun.awt.image.URLImageSource.getDecoder(URLImageSource.java:110)
 at sun.awt.image.InputStreamImageSource.doFetch(InputStreamImageSource.java:210)
 at sun.awt.image.ImageFetcher.run(ImageFetcher.java:98)



other

Synopsis: cursor is not visible while entering text into comment box 

Cursor is not visible most of the time while text is entered into comment box. 

other

Synopsis: install to an alternate directory ins not functional 

This email reports a bug on the Windows 95 platform 

After Uninstalling jde and reinstalling to an alternate directory, The following message is
displayed at launch: 

         "Couldn’t open C:\PROGRAM FILES\JAVA WORKSHOP\examples\checkers\Checkers.prj"

This may result from the path being wired. In this case the install script’s option to install to
an alternate directory is not functional. It may also be because some residual file is used to
contain the path and the uninstall procedure fails to remove it. The Checkers project is not in
the Portfolio. 

other

Synopsis: JDE caused an invalid page fault in module MFC30.DLL 

This email reports a bug on the Windows 95 platform 

I was in ’Debug’ and then tried to go into ’Build’. The main jde window was active and also
a ’JDE Build’ window. Both windows seemed to be thrashing around and not making any
progress. Finally the program aborted with the following error: 

     JDE caused an invalid page fault in module MFC30.DLL at 0137:7fb7724da

     Registers:

     EAX= 0058f1a0  CS= 0137  EIP= 7fb724da  ERFLGS= 000101216

     EBX= 0072d854  SS= 013f  ESP= 04d0f3c0  EBP= 04d0f3dc

     ECX= 00000000  DS= 013f  ESI= 058f1a00  FS= 198f

     EDX= 00000000  ES= 013f  EDI= 058f1a00  GS= 0000

     Bytes At CS:EIP:

     f7 71 08 8b 44 24 0c 89 10 8b 41 04 85 c0 74 16

     Stack Dump:

     00000000 7fb72548 058f1a00 04d0f3d8 013a2e30
     058f1a00 04d0f3e8 0155d6d0 04d28ee1 058f1a00



     058f1a00 04d33a91 058f1a00 00000000 04d33c42
     04d38040

The following was in the ’weblog.bak’ file after jde was terminated. 

[Starting jde]
[Initialize globals]
[Initializing tools]
[Creating frame]
[agent: socketIn 1032]
[Starting jde]
[Initialize globals]
java.io.IOException: recv
 at java.net.SocketInputStream.read(SocketInputStream.java:89)
 at java.io.BufferedInputStream.fill(BufferedInputStream.java:107)
 at java.io.BufferedInputStream.read(BufferedInputStream.java:121)
 at java.io.FilterInputStream.read(FilterInputStream.java:52)
 at sun.jde.Debugger.AgentIn.run(AgentIn.java:47)
 at java.lang.Thread.run(Thread.java:289)
null

Many of these. 

null
[agent: socketIn 1040]
null
[Starting jde]
[Initialize globals]
null

Many of these. 

null
java.net.UnknownHostException: mailhost
 at java.net.InetAddress.getByName(InetAddress.java:211)
 at java.net.PlainSocketImpl.connect(PlainSocketImpl.java:67)
 at java.net.Socket.<init>(Socket.java:84)
 at java.net.Socket.<init>(Socket.java:62)
 at sun.net.NetworkClient.openServer(NetworkClient.java:47)
 at sun.net.smtp.SmtpClient.openServer(SmtpClient.java:114)
 at sun.net.smtp.SmtpClient.<init>(SmtpClient.java:149)
 at sun.net.smtp.SmtpClient.<init>(SmtpClient.java:155)
 at sun.jde.util.UtLog.sendMail(UsageTracking.java:177)
 at sun.jde.util.UtLog.exit(UsageTracking.java:234)
 at sun.jde.util.UsageTracking.exit(UsageTracking.java:351)
 at sun.jde.util.UsageTracking.onExit(UsageTracking.java:340)
 at sun.jde.base.Session.exit(Session.java:138)
 at sun.jde.env.BrowserFrame.action(BrowserFrame.java:429)
 at sun.jde.env.BrowserFrame.handleEvent(BrowserFrame.java:393)
 at java.awt.Window.postEvent(Window.java:165)
 at sun.awt.Win32.MFramePeer.handleQuit(MFramePeer.java:97)
 at sun.awt.Win32.MToolkit.run(MToolkit.java:57)
 at java.lang.Thread.run(Thread.java:289)
error: mailhost

other

Synopsis: don’t allow a project to include itself 



This email reports a bug on the Windows 95 platform 

While creating a standalone application, I mistakenly set the Included Projects to be the .prj
of the standalone application. This was not diagnosed by jde. Subsequent attempts to build
the project resulted in absolutely no feedback. After trying several approaches to building the
application with no success, I tried removing the Included Project. At this, jde proceeded to
build the application at least as many times as previous attempts. I had not counted these, but
after half an hour, it seems to be looping endlessly building again and again. The close
window button would not terminate jde. I finally used Control Alt Delete to end jde. 

other

Synopsis: the "T" beam cursor does not appear in comment box 

While typing in this comment, I notice that the "T" beam cursor that does not appear in this
text widget... It appears sometimes when the I’m ’backspacing’ characters. 

other

Synopsis: web browser: doesn’t display text 

load Release Notes via Help menu
press Home button
HTML display goes blank
Refresh causes all gif’s on page to display, but none of the text is painted 

other

Synopsis: Scrollbar problem: Was viewing the page 

Scrollbar problem: Was viewing the page "doc:/lib/html/help/start/starting.html"
and when I click "down arrow" (in the scrollbar) once, it scrolls down all way. 

I notice that if the scrollbar is at its highest position, clicking on the "down arrow" will make
this happen. 

If the scrollbar is in between its highest and lowest position, the "down arrow" works as
expected. 

other

Synopsis: jde output should be redirect to weblog 

Currently, on Solaris version, jde output go to the shell output, while on Win32, jde output
get redirected to weblog. The jde fcs Solaris version should redirect its output to weblog to
be consistency with Win32. 

other



Synopsis: Intel-Win32 - browser File-Open load html file with a incorrect URL 

On window NT, when loading a html file using browser File->Open menu resulted in a bad
URL. 

For an example: 

load html file c:\java_ws\blink.html browser load in URl
file:/c:\java_ws\blink.html which is incorrect. the correct URL should be
file:c:/java_ws/blink.html 

other

Synopsis: Edit Project loops infinitely when no projects exist 

Selecting "Edit Project" icon with a portfolio selected but no projects are defined, causes
JDE to loop. It starts to build the JDE screen for Project Manager but loops after the first
icon (remove project) is drawn. I have been able to reproduce this more than once. 

other

Synopsis: on Win95, editor comes up behind browser 

Upon creating a new Java Applet OR choosing the Source Editor the "Source Editor"
window will always appear beneath the main Java WorkShop window. I would expect it to
appear directly on top of the Java WorkShop as the "primary" or "active" window. This is
the Windows95 version of the Java WorkShop Dev3. 

other

Synopsis: comments box: mail not sent on Win32 

I could not get the Comments Box to work. After I had typed in my comment I tried to send
but I did not see any modem activity. I also expect to see some sort of a "Message Sent
Successfully" screen but didn’t. My cubemate couldn’t get his to work either. It just sits
there when you send. Does nothing. 

other

Synopsis: on Win95 truncated label 

When selecting "Create a new project", five items will be displayed, such as Applet,
Standalone Program, Java Package, Image, Imported Applet. But running on Windows 95,
the label of "Imported Applet" is cut like "Impor". 

Sorry I can not get the snapshop on Windows 95. 

other



Synopsis: changes to the data in projects should notify other tools 

Currently there is no method called when a project’s data, we need one analagous to when
changing projects. So that when a users changes source path, class path or run arguments for
example the debugger is notified. 

other

Synopsis: Bold and italic fonts not displayed correctly 

The bold and italic fonts are not displayed correctly in the browser. They appear to be
different fonts and/or point size than the regular typeface. 

srcbrowser

Synopsis: query history keep duplicate search word in the history list 

Each time string search operation is perform, sourcebrowser enter the search string into
query history list even if the search string is already in the list. As a result, the history list
contain the duplication of search strings. 

srcbrowser

Synopsis: On Win95, when clicking on a link, the jde window is on top of the text window 

On Win95, when clicking on a link, the jde window is on top of the text window. The text
window did come up on top of the jde window but was move the back. To reproduce the
problem: --------------------- - type in a string in the string field. - select one of the links. - the
text window will pop up and moved to the back of jde. 

srcbrowser

Synopsis: Intel-Win32 - string search window horizontal scroll bar doesn’t work 

On window NT and window 95, string search horizontal scroll bar doesn’t work. 

web_browser

Synopsis: jde browser catch ClassNotFoundException when no class existed for html file 

When loading a html file, if there is no class existed for the applet, jde browser caught the
following exception. jde should return an error to users instead of catch an exception. 

dnp91% jde
[Starting jde]
[Initialize globals]
[Creating common button bar]
[Creating frame]
Thread-7 find class Bubbles



File not found when looking for: Bubbles
load: class Bubbles not found
java.lang.ClassNotFoundException: Bubbles
        at sun.jde.web.AppletClassLoader.loadClass(AppletClassLoader.java:140)
        at sun.jde.web.AppletClassLoader.loadClass(AppletClassLoader.java:102)
        at sun.jde.web.AppletPanel.run(AppletPanel.java:251)
        at java.lang.Thread.run(Thread.java)
dnp92% 

web_browser

Synopsis: Win32 - browser hangs when starting up 

I get the following dump from the weblog, the splash page doesn’t show up, and the
lighthouse just keeps spinning. 

[Starting jde]
[Initialize globals]
[Creating common button bar]
[Creating frame]
java.lang.NoSuchFieldError: sun.jde.web.Paragraph: field rows not found
        at sun.jde.web.Paragraph.<init>(Paragraph.java:34)
        at sun.jde.web.TagView.paragraphBreak(TagView.java:201)
        at sun.jde.tags.P.putFinished(P.java:32)
        at sun.jde.web.TagView.put(TagView.java:114)
        at sun.jde.web.TextView.put(TextView.java:195)
        at sun.jde.web.PageParser.tag(PageParser.java:143)
        at sun.jde.util.HTMLParser.parseTag(HTMLParser.java:291)
        at sun.jde.util.HTMLParser.parse(HTMLParser.java:102)
        at sun.jde.web.PageParser.run(PageParser.java:116)
        at java.lang.Thread.run(Thread.java:289)
java.lang.NoSuchFieldError: sun.jde.web.Paragraph: field rows not found
        at sun.jde.web.Paragraph.<init>(Paragraph.java:34)
        at sun.jde.tags.HR.<init>(HR.java:27)
        at sun.jde.web.TagView.getInstance(TagView.java:254)
        at sun.jde.web.PageParser.tag(PageParser.java:142)
        at sun.jde.util.HTMLParser.parseTag(HTMLParser.java:291)
        at sun.jde.util.HTMLParser.parse(HTMLParser.java:102)
        at sun.jde.web.PageParser.run(PageParser.java:116)
        at java.lang.Thread.run(Thread.java:289)
Starting JDE...

web_browser

Synopsis: violate security caught security exception 

When user violate applet security, jws browser caught a security exception. jws should give
an error message in the browser for security violation. 

The following applet will produce a security violation. 

<applet  codebase=http://www.investorsedge.com/java/dev code=StockTicker.class width=500 height=25>
<param name=scrollt value="95">
<param name=deltat value="1000">
<param name=stocks value="|ACO|ANRG|CATP|CNE|COL|DBCC|DEC|EXTL|FMT|GENIZ|GND|HOU|KLT|KMAG|MATX|MPL|MU|NAC|NES|NWK|ONTK|OSG|SCE|SUNW|SYBS|T|TALK|TRB|VC|USMX|UUNT|WMB|WR|XRX">
<param name=staticdata value="/scripts/ethos.exe?WWW+p_IECorporateProfileJava+’IE’">
<param name=fudge value=false>



<param name=bgcolor value=black>
</applet>
[Starting jde]
[Initialize globals]
[Creating common button bar]
[Creating frame]
Warning: 
    Cannot allocate colormap entry for default background

Thread-7 find class StockTicker
Opening stream to: http://www.investorsedge.com/java/dev/StockTicker.class to get StockTicker
Thread-7 find class StockWatcher
Opening stream to: http://www.investorsedge.com/java/dev/StockWatcher.class to get StockWatcher
Thread-7 find class TickerPaintDaemon
Opening stream to: http://www.investorsedge.com/java/dev/TickerPaintDaemon.class to get TickerPaintDaemon
Thread-7 find class QuoteQueue
Opening stream to: http://www.investorsedge.com/java/dev/QuoteQueue.class to get QuoteQueue
Thread-7 find class QuoteSnapshot
Opening stream to: http://www.investorsedge.com/java/dev/QuoteSnapshot.class to get QuoteSnapshot
Thread-7 find class StockStreamParser
Opening stream to: http://www.investorsedge.com/java/dev/StockStreamParser.class to get StockStreamParser
*** Security Exception: file.read:/scripts/ethos.exe?WWW+p_IECorporateProfileJava+’IE’ ***
sun.jde.web.AppletSecurityException: Applets can’t read this file.: /scripts/ethos.exe?WWW+p_IECorporateProfileJava+’IE’
        at sun.jde.web.AppletSecurity.checkRead(AppletSecurity.java:266)
        at sun.jde.web.AppletSecurity.checkRead(AppletSecurity.java:237)
        at java.io.FileInputStream.<init>(FileInputStream.java)
        at sun.net.www.protocol.file.FileURLConnection.connect(FileURLConnection.java:67)
        at sun.net.www.protocol.file.FileURLConnection.getInputStream(FileURLConnection.java:74)
        at java.net.URL.openStream(URL.java:333)
        at StockStreamParser.run(StockStreamParser.java:149)
        at java.lang.Thread.run(Thread.java)
sun.jde.web.AppletSecurityException: Applets can’t read this file.: /scripts/ethos.exe?WWW+p_IECorporateProfileJava+’IE’
        at sun.jde.web.AppletSecurity.checkRead(AppletSecurity.java:266)
        at sun.jde.web.AppletSecurity.checkRead(AppletSecurity.java:237)
        at java.io.FileInputStream.<init>(FileInputStream.java)
        at sun.net.www.protocol.file.FileURLConnection.connect(FileURLConnection.java:67)
        at sun.net.www.protocol.file.FileURLConnection.getInputStream(FileURLConnection.java:74)
        at java.net.URL.openStream(URL.java:333)
        at StockStreamParser.run(StockStreamParser.java:149)
        at java.lang.Thread.run(Thread.java)

Further information 

Other places you might want to look:

URLs: 

http://www.javasoft.com/, the home page for JavaSoft. 

http://www.javasoft.com/hooked/, area for the book Hooked on Java 

http://www.io.org/~mentor/DigitalEspresso.html, Java mailing list and newsgroups
summaries. 



http://www.dimensionx.com, applets and info on Java. 

http://ugweb.cs.ualberta.ca/~nelson/java/AWT.Tutorial.html, a tutorial on the AWT (Abstract
Windows Toolkit) 

http://www.digitalfocus.com/digitalfocus/faq/howdoi.html, a JAVA FAQ on all sorts of
stuff. 

http://amber.wpi.edu/~thethe/Documents/Besiex/Java/FrIJDE/, the Free Integrated Java
Development Environment (FrIJDE, pronounced "frigid") Project is a world-wide effort to
create a free, platform-independent, fully-extensible, instantly-upgradable development
environment for the Java programming language. 

http://www.gamelan.com/, Home of some great applets! 

Newsgroups: 

comp.lang.java 

e-mail: 

java@java.sun.com 

 

Questions or comments regarding this service? webmaster@sun.com
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